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Введение
Обоснование выбора способа печати

Используемый способ печати – флексография, так как печатать на кэшированном
гофрокартоне возможно только с гибких

и эластичных полимерных печатных форм. Еще она важная особенность
флексографии: в отличие от классической высокой печати, где краски вязкие,
здесь используются жидкие краски на водной или спиртовой основе, а также
краски с УФ-отверждением, которые затвердевают в результате химических
реакций, идущих при ультрафиолетовом облучении. Последний тип красок весьма
удобен, поскольку нет необходимости в сушке (и, как следствие, в системах
очистки воздуха), краски в процессе печати не растекаются и изображение
получается более качественным и насыщенным, кроме того, такой красочный слой
более устойчив.

1. Оригинал
Оригинал – плоское стационарное во времени изображение, изготовленное
различными способами.

По способу создания изобразительные оригиналы делятся на:

- рисованные оригиналы, выполненные на непрозрачной основе с применением
художественной техники (тушью, гуашью, акварелью);

- фотографические аналоговые оригиналы, выполненные на непрозрачной
(фотографии) и прозрачной основе (слайды, негативы, диапозитивы);

- оригиналы, изготовленные полиграфическим способом;
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- фотографические цифровые оригиналы (цифровые фотографии);

- оригиналы, созданные методом сканирования, и поступающие, например, из базы
данных или с цифрового носителя.

В зависимости от исполнения и назначения:

- оригиналы, предназначенные специально для полиграфического воспроизведения
с учетом выбора определенного технологического процесса и оборудования
(форзацы, фронтисписы, обложки, внутриполосные изображения и т.д.);

- оригиналы, выполненные без учета их полиграфического воспроизведения
(произведения живописи, документы, полиграфические оттиски и др.).

Первая группа оригиналов является основной, они широко применяются в
полиграфическом производстве.

В зависимости от числа градаций оригиналы делятся на двухградационные,
имеющие два уровня оптической плотности (яркости) – штриховые оригиналы,
тоновые оригиналы, имеющие бесконечное число множество оптических
плотностей, и многоградационные оригиналы, имеющие более двух, но не
содержащие бесконечного множества оптических плотностей.

В зависимости от цветности оригиналы могут быть одноцветные, многоцветные и
полноцветные.

Рост числа применяемых форм представления информации и типов носителей
информации позволил использовать для воспроизведения цифровые изображения,
требующие специальных технических средств визуализации и специальных
носителей информации.

Различные типы оригиналов могут быть воспроизведены теми или иными
способами в системах одновременной форматной и последовательной
поэлементной обработки изображения.[1]

В данном проекте оригиналы – фотографические цифровые многоградационные,
хранящиеся на магнитном носителе. Информация в них представлена в цифровом
коде в виде числового массива.



2. Анализ оригинала и выработка стратегии
обработки
Сложные по градации, цветности, с наличием мелких деталей изображения
оригиналы обрабатываются в системах поэлементной обработки разных типов.

Стратегия обработки: использование СПОИ – компьютерной издательской системы
(КИС), то есть системы, имеющей модульное построение. В таких системах
возможен ввод информации в виде готовых файлов, например, с цифровых
фотокамер или из баз данных.

Таким образом, цифровые оригиналы поступают непосредственно во второй блок
СПОИ – персональный компьютер на платформе Macintosh с предварительно
откалиброванным монитором.

2.1. Калибровка монитора
Калибровка монитора и его эксплуатация должна осуществляться в помещении,
которое обеспечивает отсутствие интенсивного внешнего освещения экрана и тем
более какую-то окраску этого освещения. Окна должны быть затемнены, стены
окрашены в нейтральный серый цвет. Цветовая температура освещения
помещения должна быть близка к цветовой температуре экрана монитора.
Калибровка производится спектрофотометром.

Используемый компьютер:

Модель: Apple Macintosh iBook G4

Тип процессора: PowerPC G4 (3.3)

Скорость процессора: 933 MHz

Объем кэш-памяти: 256 KB

Объем оперативной памяти: 384 MB

Необходимая текстовая информация вводится с использованием ПО Microsoft Office
– MS Word, или непосредственно в программе верстки (например, Adobe InDesign).



Обработка изобразительной информации – коррекция градации, учет профиля
печатного процесса, базовая и селективная цветовая коррекция – производится в
программе Adobe Photoshop.

Верстка, треппинг, спуск полос и PostScript-файл для вывода на CtP-устройство
создаются в программе верстки.

Цветопроба выводится с PostScript-файла.

Для создания печатных форм используется технология Computer-to-
Flexoprint(CtflexoP).

3. Ввод и обработка текстовой и изобразительной
информации

3.1. Ввод текстовой информации
Поскольку собственно текста на коробке немного, но он достаточно сложно
оформлен, разумно использовать для ввода сразу программу верстки – Adobe
InDesign. Для этого необходимо создать модульную сетку, повторяющую очертания
и размеры макета, и ввести с клавиатуры требуемые данные.

3.2. Обработка текстовой информации
При размещении текста важно учитывать хотя бы основные правила типографики:
соблюсти кернинг и трекинг – оба параметра влияют на пробельное пространство,
но кернинг относится только к выделенным парам букв, в то время как трекинг – к
выделенному фрагменту текста или ко всему документу; использовать не более
двух, а лучше одну гарнитуру – для создания ощущения целостности, более того,
для нормального воспроизведения при флексопечати эта гарнитура должна быть
гротескной, или брусковой. Переносы нужно отключить. Важно также правильно
оформить выключку и не забыть о правильной расстановке знаков препинания –
использовать полиграфическое тире (em dash), полиграфический дефис (en dash),
“правильные” троеточия и т.п.[5]



3.3. Форматы шрифтов: TrueType, PostScript,
OpenType
Оба формата задают контурное описание формы литер, то есть описывают форму
букв так, как это делают векторные программы с контурами в изображении.
Разница между ними в том, что формат TrueType, описывая контуры, использует
кривые второго порядка, PostScript - кривые третьего порядка. В формате PostScript
формы контуров описывает один файл - *.pfb, а все метрические (количественные)
характеристики шрифта записаны в отдельном файле, имеющем то же имя и
расширение *.pfm.

Обработкой инструкций и визуализацией шрифта для данных условий занимается
отдельная программа – менеджер шрифтов ATM (Adobe Type Manager). Для фор­
мата TrueType все инструкции сведены в отдельный файл, и управлением шрифта
занимается непосредственно операционная система. Строение файла TrueType
шрифта сложнее, чем шрифта PostScript, поскольку здесь часть функций,
отдаваемых менеджеру печати, внедрена в сам шрифт. Однако у солидных про­
изводителей шрифтов обычно существуют и PostScript, и TrueType версии одной и
той же гарнитуры, созданные на основе одного эскиза шрифта в программе
шрифтового дизайна.

ОрепТуре: проблему кроссплатформенной (Macintosh - PC) совместимости шрифтов
решает использование ОреnТуре. Этот формат был разработан совместно фирмами
Adobe и Microsoft. Хотя соглашение о создании формата было обнародовано еще в
1990 году, реальное распространение эти шрифты получили только в последние
пару лет и являются наследниками как TrueType, так и Typel (PostScript). To есть
шрифты ОрепТуре могут иметь контуры, описываемые как кривыми третьего
порядка (как в Typel-шрифтах), так и кривыми Безье (кривыми второго порядка, как
в TrueType-шрифтах). В первом случае файлы шрифтов имеют расширение OTF, во
втором -расширение TTF.[3]

3.4. Ввод изобразительной информации
Необходимые цифровые оригиналы поступают с цифровой фотокамеры.

Используемое оборудование: камера Canon Mark II, штатив.



После сохранения оригиналов на жестком диске компьютера, их можно
просмотреть с помощью программы Adobe Photoshop. Для этого необходимо
открыть программу, выбрать пункт меню File->Open... и выбрать в браузере нужные
файлы.

3.5. Обработка изобразительной информации
Необходимо использовать цветовую модель CIELab, поскольку считается, что Lab
является аппаратно-независимой моделью, то есть цвет описывается описывается
независимо от сформировавшего его конкретного устройства. Однако, в модели
CIELab (L – яркость, a и b – цветовые каналы) цвет объекта определяется
параметрами белого цвета. Значения белого в разных стандартах сильно разнятся.
Но, несмотря на недостатки, на сегодняшний день Lab является наиболее
продвинутой моделью. Переключение в модель Lab в Adobe Photoshop
производится так: Image->Mode->CIELab.

3.5.1. Учет цветового профиля
В основе идеи профилирования лежит понятие об аппаратно-независимом
цветовом пространстве, посредством которого производится обмен численной
информацией о цвете, например, между сканером и принтером. Обычно в роли
пространства привязки профилей выступает CIE Lab или CIE XYZ. Если профилей
нет, каждая пара устройств использует свой алгоритм передачи цветовых
значений. При наличии цветового профиля сведения о цвете, полученные от
любого устройства ввода, переводятся в CIE Lab, а потом поступают на устройство.
Числовые данные цветового профиля представляют собой матрицу или таблицу из
двух столбцов, в которых прописаны данные CMYK или RGB и соответствующих им
значений CIE Lab (или CIE XYZ).

В профиле может описываться конкретное устройство (такие профили обычно
создаются с помощью программ и аппаратуры для калибровки) или класс устройств
(принтеры определенной модели), или абстрактное цветовое пространство (Adobe
RGB и т.п.). В Windows используются ICC-профили - по названию International Color
Consortium (Международный консорциум по цвету) – организации, установившей
стандарт.



При преобразовании происходит или изменение характеристик некоторых цветов,
или(/и) усечение цветового пространства. Подробнее рассмотрим существующие
способы конвертирования цвета:

- Perceptual. Способ преобразования на основе воспринимаемых цветов. Сохраняет
внешний вид картинки с точки зрения человеческого глаза. Изменения значений
цветов разрешены;

- Saturation. Способ с сохранением насыщенности. Переводит яркие, насыщенные
цвета исходного пространства в насыщенные цвета конечного. При этом оттенки
могут меняться. Способ хорош для, так называемой, бизнес-графики (диаграммы,
схемы) и категорически не годится для фотографии;

- Relative Colorimetric. Относительный колориметрический способ. Преобразует
белый цвет так, чтобы области белого в исходном пространстве соответствовали
областям белого в конечном. То есть абстрактный абсолютно белый преобразуется
в белый цвет бумаги. Оттенки, оказавшиеся за пределами цветового пространства,
округляются до ближайшего воспроизводимого на данном оборудовании;

- Absolute Colorimetric. Абсолютная колориметрия. Способ аналогичен
относительной колориметрии, но белый не преобразуется.

Профиль устройства содержит:

- информацию о цвете и яркости основных цветов, используемых устройством;

- информацию о цвете и яркости черной и белой точек;

- тоновые характеристики красок.

Профили могут, как уже было сказано, представлять собой матрицу или таблицу. В
первом варианте числа записываются в матрицу 3x3 (массив из 9 чисел),
позволяющую пересчитать первоначальные значения цвета. При этом описывается
все пространство возможных цветов. Такие профили весьма компактны. При
табличном способе определенным точкам в исходном цветовом пространстве
соотвествуют значения CIE Lab или CIE XYZ. Чем больше строк в таблице, тем
точнее преобразование, но больше размер файла профиля.

Профилирование оправдано лишь для аппаратуры, сохраняющей достаточно
высокую стабильность своих характеристик во времени. Лучшим доказательством
этого являются мониторы. Если характеристики электронно-лучевой трубки



нестабильны, то профиль, созданный неделю назад, окажется бесполезным.[3]

3.5.2. Базовая цветовая коррекция
Базовые недостатки цветоделения связаны с тем, что краски полиграфического
оборудования обладают рядом недостатков и отличаются от идеальных красок.
Голубая краска имеет избыточное поглощение в синей и зеленой зонах и
недостаточное поглощение в красной зоне. Пурпурная краска имеет избыточное
поглощение в синей зоне и недостаточное поглощение в зеленой зоне. Желтая
краска по своей характеристике наиболее близка к идеальной.

В результате этих недостатков красок в процессе цветоделения в следствие
избыточности поглощения голубой краски в синей и зеленой зонах эта краска
выделяется не только за красным светофильтром, но также за синим и зеленым.
Это приводит к тому, что если не принять специальных мер коррекции, голубая
краска выделится на синефильтровой и зеленофильтровой фотоформе будет
запечатываться соответственно желтой и пурпурной краской.

Соответственно избыточное поглощение пурпурной краски в синей зоне будет
приводить к выделению этой краски на синефильтровой фотоформе и
следовательно желтая краска будет ложиться на пурпурные места.

Эти недостатки цветоделения называются базовыми. Для устранения этих
недостатков при фотографическом цветоделении используются методы
маскирования.

В принципах цифровой обработки эти недостатки могут устраняться путем
вычитания электрических сигналов соответствующих каналов друг из друга, то
есть по сути дела могут выполняться процессы аналогичные процессам
фотографического маскирования, но выполненные электронным путем. Такие
методы использовались в цветокорректорах предыдущего поколения.

Однако, в современных системах цифровой обработки, использующих методы
построения ICC профилей, эти базовые недостатки цветоделения устраняются
процессом самого использования ICC профиля для перехода от колориметрических
системы координат Lab к системе координат CMYK. По сути дела, при правильной
настройке системы и правильной работе в соответствующих цветовых
пространствах, задача базовой коррекции решается автоматически и



дополнительных мер по базовой коррекции принимать нет необходимости. В этом
случае, если цветовой охват репродукции больше чем цветовой охват оригинала,
то цвета оригинала будут правильно переданы цветами печатного оттиска.[2]
Таким образом, в модели CMYK черный цвет теоретически должен был бы фор­
мироваться из смеси 100% всех триадных красок, однако такой цвет является
скорее темно-коричневым и его оттенок сильно завит от свойств самих красок. В
свою очередь, использование только черной краски дает неглубокий, блеклый
черный. Похожая ситуация и с серым цветом. Теоретически возможно формировать
серый из составного и чистого черного. Составной черный получается более
«живым» цветом, но зачастую имеет тот или иной оттенок и выглядит более
теплым, чем однокрасочный серый. Для получения составного серого желтая и
пурпурная краски берутся поровну, синей же добавляется больше почти на треть.
Формирование составного серого является одной из характеристик
полиграфического процесса (так называемый баланс по серому). В RGB или Lab нет
проблемы составного серого и черного. Выделение черного происходит при
преобразовании цветовой модели. Существуют два алгоритма преобразования:
GCR и UCR. Второй предполагает выделение однокрасочного черного только в тех
местах изображения, где цвет действительно приближается к черному. В этом
случае на черной пленке проявятся только наиболее темные области. Первый
способ, называемый «вычитанием серого», позволяет генерировать черный канал
при любом проценте серого. Генерация серого настраивается в Photoshop в меню
Color Settings. Чтобы попасть в это меню, необходимо выполнить команду Edit ->
Color Settings и выбрать для CMYK вариант Custom.

Иногда генерация серого может стать одним из этапов цветокоррекции изобра­
жения. На фотореалистичной картинке почти весь черный - составной.
Максимальное суммарное покрытие и максимальное содержание черной краски ре­
гулируется все в том же меню Color Settings. Настройки генерации серого сильно
влияют на содержимое канала черного после преобразования картинки из
цветового пространства RGB или Lab в CMYK.

В фотореалистичном изображении максимальное содержание черного, как и
любого другого цвета, не должно превышать 95%. При 100% мы получаем плашку,
то есть сплошное покрытие бумаги данной краской, что скажется на покрытии того
же участка другими красками и в итоге даст неприятные пятна, - вызванные
нарушением плавности перехода от одного цвета к другому. Считается
общепризнанным, что общее покрытие в 400% (100C+100M+100Y+100B) следует
объявить браком - при таком количестве краски бумага деформируется, кроме



того, с каждым новым слоем (прогоном) нарушаются впитывающие свойства
материала, и краска, наносимая последней, плохо впитывается, пачкает обратную
сторону бумаги (возникает так называемый переоттиск). Величина суммарного
покрытия должна составлять 260-320%. Предельно допустимое значение в
большой степени зависит от качества материала, на который наносится краска.
для некачественной, например газетной, бумаги этот показатель ниже, для
дорогих, мелованных бумаг - выше.[3]

Еще один показатель, также настраиваемый в процессе преобразования RGB/Lab-
CMYK - это растискивание (dot gain). Этот параметр очень важен для формирования
качественного изображения. Принтер наносит на бумагу краски точками. Чем
бледнее цвет, тем точки мельче, чем цвет интенсивнее, тем точки крупнее, напри­
мер, при градиентной заливке очень мелкие точки плавно сменяются более
крупными. Попав на бумагу, любая капля краски (которой и является точка),
естественно, растекается. Процент, на который точка при этом увеличивается, и
называется растискиванием. Если растискивание не учесть, это может повлиять на
плавность градиентных переходов в областях с большим количеством краски (75%
и более). Ведь если растискивание значительное, а размер точки не
скомпенсирован, может случиться так, что границы расплывшихся точек сомкнутся
уже при 80% покрытия определенной краской, тогда переход от 80% к 100%
(точнее, как уже говорилось, к 95%) исчезнет, и мы вместо перехода получим
сплошное пятно или “эффект постеризации”. Величина растискивания, на самом
деле, зависит от качества бумаги, исходя из этого следует назначать и линиатуру
вывода, но об этом мы поговорим отдельно и позднее.[2]

В флексографской печати минимальный диаметр точки на фотоформе должен быть
больше, чем размер ячейки анилоксового вала. Исходя из этого, во-первых,
нередко оказывается невозможным плавный растровый переход от 0 к 3-5% цвета.
Изображение появляется скачкообразно в области 3% или более, что дает
нериятное впечатление “постеризации” на светлых участках. Кроме того,
необходимо с осторожностью применять механизмы частотно-модулированного
растрирования, рассчитанные на использование точек минимального размера. В
настоящее время существуют алгоритмы ч/м растрирования для флексопечати,
более того, предполагается, что это позволит создавать плавные градиенты до 0%.

3.5.3. Селективная цветовая коррекция



При селективной цветовой коррекции, то есть коррекции цвета по отдельным
цветам изображения, производится коррекция цвета по отдельным признакам: по
насыщенности или цветовому тону.

Селективная цветовая коррекция позволяет корректировать цвет не всего
изображения, а отдельных участков изображения, отличающихся по цветовому
тону и насыщенности.

Предусмотрены следующие типы селективной цветовой коррекции:

- секторная коррекция. Эта селективная цветовая коррекция позволяет изменять
цвет по цветовому тону или насыщенности при этом воздействие производится на
некоторую группу цветов ограниченных некоторым сектором плоскости цветности.
Например, хотим обработать цвет лица. Он относится какому-то сектору плоскости
цветности. Мы активизируем этот сектор и в нем изменяем необходимые цвета.
При этом воздействие осуществляется на все цвета, находящиеся в данном
секторе и не затрагивает другие сектора.

Преимуществом такой коррекции является мягкость цветовых переходов между
корректируемыми и некорректируемыми секторами плоскости цветности,
отсутствие появления каких-либо ложных границ в изображении;

- точечная коррекция. Мы корректируем цвет определенной точки цветового
пространства, при этом корректируются все точки, имеющие такой цвет. Такая
коррекция может привести к резкому выделению корректируемого цвета из
окружающего пространства, то есть такая коррекция может привести к появлению
ложных границ. Поэтому такая селективная коррекция обычно применима для
изменения цвета каких-либо участков, имеющих постоянный цвет и как правило
ограниченных какими-либо четкими границами.

- селективная цветовая коррекция в выбранной зоне. Она является промежуточной
между сектороной и точечной. При такой цветовой коррекции мы сами определяем
ту зону цветового пространства, которое хотим подвергнуть коррекции по цвету.
Эту коррекцию можно проводить как по цветовому тону, так и по насыщенности
используя соответствующие координаты LCH или HSB.

Возможен предварительный анализ путем выделения тех цветов, которые
находятся вне цветового охвата репродукции. Для этого существует специальная
подпрограмма выделения неохватных цветов. Эти участки могут быть подвергнуты
селективной цветовой коррекции по методам секторной коррекции или коррекции



в выбранной зоне и соответственно таким образом может быть изменена
насыщенность и эти участки изображения могут быть введены в цветовой охват
репродукции без потери резкости деталей изображения.[6]

Такая селективная коррекция, как правило, освобождает от необходимости
использования специальных масок выделяющих геометрическую площадь.
Применение таких масок стоит избегать в следствии того, что геометрическое
выделение области чревато появлением ложных границ в изображении, которые
потом необходимо дополнительно размывать теряя резкость изображения.

4. Верстка
Версткой называют производственный процесс составления (монтажа) книжных,
журнальных, плакатных и газетных полос заданного формата из подготовленного
набора всех видов и иллюстраций.

Верстка - один из основных процессов полиграфического производства, в ходе
которого печатное произведение приобретает окончательный вид. От качества ее
выполнения прямо зависит качество готовой книги, журнала, упаковки или газеты.

4.1. Треппинг
Треппинг – узкая полоска смешения цветов на границе разноцветных объектов
полосы, необходимую для коменсации дефектов приводки, монтажа и деформации
бумажного листа внутри печатной машины, вызывающих появление на тиражном
оттиске незакрашенных участков бумаги. Механизм треппинга определяет, помимо
прочего, отношение Knockout (в QuarkXPress), необходимое для устранения
паразитного смешивания цветов на тиражном оттиске, и отношение Overprint,
гарантирующее смешение цветов на полосе.[7] Треппинг бывает “внутренний” и
“внешний”. Так называемый «внешний треппинг» заключается в том, что объект
заходит на подложку. «Внутренний», соответственно, наоборот.

На самом деле, треппинг чаще всего используется для крупных надписей, чем для
графических объектов, которые обычно стараются скомпоновать так, чтобы не
было необходимости в треппинге.



4.2 Вывод PostScript
На этапе вывода информации доминирует язык описания страниц PostScript.
Являясь аппаратно-независимой структурой данных, PS может использоваться для
управления целым рядом выводных устройств. Как язык программирования для
пользователя PostScript почти незаметен. Он генерируется, как правило, драйвером
компьютерной системы(в программе верстки), по сети передается на устройство
вывода, транслируется интерпретатором RIP(Rasterizing Image Processor,
специальный процессор, преобразующий полутоновое изображение в множество
растровых точек) в коды устройства вывода(чаще всего в битовые карты).

Специальный вариант массива данных PostScript представляет собой формат
DCS(Desktop Color Separation). В массиве данных DCS четыре цветоделенные
фотоформы сохраняются как четыре отдельных файла в общем PS-файле.[4]

Завершающим этапом подготовки макета является внесение направленного
искажения (дисторсии). Связано это с тем, что гибкая полимерная форма при
наклеивании ее на формный цилиндр, растягиваясь, увеличивается в размере по
окружности цилиндра (в направлении печати). Поэтому изображение на пленке
должно быть меньше на величину этого растяжения. Обычно эта величина зависит
от длины раппорта и может быть рассчитана теоретически, а более точно —
эмпирически. В результате получается коэффициент, который может быть
выражен в процентах (обычно уменьшение составляет 95-99%). Иногда внесение
дисторсии называют аморфным масштабированием.[3]

Перед записью PS-файла необходимо внести это уменьшение по одному
направлению.

Для вывода PostScript-файла из программы верстки Adobe InDesign в ОС MacOS
необходимо проделать следующие операции:

1. File > Print.

2. В диалоговом окне Indesign Print выбрать «Printer...»

3. В диалоговом окне драйвера принтера, выбрать Output Options из выпадающего
меню.In the printer driver’s dialog box, choose Output Options in the pop-up menu.

4. Выбрать «Save as File».



5. Выбрать PostScript в меню «Format» и нажать Save.

6. Указать местоположение и имя нового файла, после чего нажать Print.[7]

4.3 Растрирование
Растрирование – это преобразование полутонового электронно-цифрового
изображения в микроштриховое, состоящее из отдельных растровых элементов.

Признаки, характеризующие структуру растрового изображения:

1.Частота растра или его линиатура:

- растры низкочастотные (низколиниатурные) – используются для газет раньше
были 16-40 лин/см, сейчас с переходом на печать газет офсетным способом стали
30-34 лин/см;

- растры средней линиатуры: 48-60 лин/см;

- высоколиниатурные растры: 70-120 лин/см.

С развитием техники растр 70 лин/см переходит в среднелиниатурную группу.

2. Регулярность или нерегулярность растра. Регулярный растр имеет
периодическую решетку, в которой все точки сконцентрированы возле узлов
решетки и расстояние между точками одинаковое. В нерегулярных растровых
структурах растровый элемент расположен случайно по площади растрового поля.

3. Структура растровой точки (форма растровой точки).

4. Угол поворота растра: в флексографии используются нестандартные углы
поворота растра, однако, пока флексопечать не стандартизована, существуют
только рекомендуемые значения поворота: Cyan – 7,5°, Magenta – 67,5°, Yellow –
82,5°, Black – 37,5°.[3]

5. Цветопроба
Цвет на экране и на печати формируется принципиально по-разному. Для контроля
соблюдения соответствия цветов на экране и на оттиске используется цветопроба,



которая должна служить эталонным изображением в процессе печати тиража. При
этом должно быть учтено качество бумаги и способ печати.

Цветопробы можно подразделить на несколько типов. В настоящее время исполь­
зуются аналоговые и цифровые цветопробы. Цифровая цветопроба производится
средствами печати определенных типов, при этом не только максимально точно
повторяется растровая структура оттиска, но и имитируется, например,
растаскивание. Иногда цифровая цветопоба воспроизводит даже не тиражный
оттиск, а определенную аналоговую.

Методы цифровой цветопробы используются для вывода цифровых данных с целью
обеспечения максимально приближенного моделирования изображения, которое
будет получено при печати тиража. При этом в большинстве случаев речь идет о
визуальном совпадении с печатным оттиском, который будет получен позднее(т.н.
Color-Proof). В цифровых системах цветопробы в зависимости от назначения и
требований к качеству различают два основных метода: SoftProof –
“мягкая”(экранная) цветопроба и HardProof – “твердая”(цветопроба на
материальном носителе).

5.1. “Мягкая” цветопроба
Моделирует изображения на мониторе. Благодаря применению формата PDF в
сочетании с системой управления цветом достоверность экранного
воспроизведения достаточная для предъявления ее заказчику.

5.2. «Твердая» цветопроба
Делится на 5 дополнительных методов, а именно:

- Светокопия(однокрасочная «синька»);

- Цветопроба верстки полос(производится на широкоформатном плоттере);

- Цветопроба(свидетельствует о пригодности файла для вывода, служит
ориентиром для печатника, отвечающего за тираж);

- Растровая цветопроба(TrueProof, «истинная» цветопроба, служит для выявления
дефектов, обусловленных растровой структурой);



- Пробная печать(выполняется на пробопечатном станке, от 50 до 100
экземпляров).[4]

6. Формные процессы
На сегодня технология цифровой записи фотополимерных форм для флексографии
набрала обороты и составляет конкуренцию уже ставшему традиционным
аналоговому процессу изготовления форм.

Гибкие фотополимерные формы пришли на смену использовавшейся ранее, около
30 лет назад, резине и за это время стали одной из основ технологии. Принцип
записи формы лежит в фотополимеризующихся материалах, т.е. тех, которые
закрепляются под действием излучения (в данном случае — ультрафиолетового).

В связи с этим для засветки формной пластины используются негативы, читаемые
со стороны эмульсии. Классический процесс получения аналоговой формы состоит
из экспонирования обратной стороны, основного экспонирования, проявления,
сушки, финишинга и дополнительного экспонирования.

Таким формам свойственно высокое растискивание, а следовательно, расширяется
круг проблем, связанных с передачей градаций полутонов изображения. Решить
эти, а также многие другие проблемы было предначертано технологии Computer-
To-Plate, которая демонстрирует более стабильные параметры печати.[8]

На сегодня CTP — перспективное направление развития флексографской
технологии. Ведь именно с помощью этого способа сегодня можно добиться
максимального качества и выйти на уровень, близкий к уровню офсетной печати.

В первую очередь, как видно из названия, исключено изготовление фотоформ, что
позволило сократить время допечатной подготовки. Негатив заменен черным
маскирующим слоем, который, кроме всего прочего, защищает пластину от
отрицательного воздействия кислорода, замедляющего процесс полимеризации
материала. Впоследствии этот слой обрабатывается лазерным экспонирующим
устройством, и в том месте, где прошел лазер, фотополимер обнажается. За счет
того же маскирующего слоя удается получить растровую точку, меньшую, чем
пятно, которое выжег лазер на этом самом слое (в отличие от аналогового
процесса, где точка неминуемо увеличивается по сравнению со своим «собратом»
на пленке). Этим в основном и обуславливается меньшая величина растискивания.



Цифровое изготовление фотоформы состоит из лазерного гравирования
маскирующего слоя, экспонирования обратной стороны, основного экспонирования,
проявления, сушки, финишинга и дополнительного экспонирования.

Основные преимущества цифровой формы перед аналоговой:

- Меньшее светорассеяние за счет непосредственного прилегания маскирующего
слоя к пластине (чего нельзя добиться даже при вакуумном прижиме негатива);

- Более плавные градационные переходы;

- Более высокий уровень проработки деталей в светах и тенях;

- Снижение прироста диаметра растровой точки при экспонировании;

- Возможность совмещения растровых изображений с плашкой на одной форме;

- Лучшая проработка тонких штрихов, шрифтов с малым кеглем, вывороток;

- Возможность получения точной копии формы с того же PS-файла и передача
информации на запись с помощью систем удаленного доступа.

- Истинная линиаризация печатного процесса (по оттиску), а не
псевдолиниаризация по фотопленкам, как в аналоговом процессе.[4]

7. Изготовление печатной формы с помощью
технологии CTP
Изготовление флексографских печатных форм по технологии ComputertoPlate
может осуществляться двумя способами: прямым лазерным гравированием
флексографских форм и с использованием маскированных фотополимеров.

При прямом гравировании формирование печатных элементов происходит путем
непосредственной обработки исходного материала (резины или специальных
полимеров) лучом лазера, причем готовая форма получается сразу после лазерной
обработки. Главное достоинство этой технологии состоит в том, что форма
изготавливается за один технологический этап на одной единице
технологического оборудования.



Прямое гравирование уже давно и широко используется на предприятиях
флексографской печати для изготовления резиновых печатных форм, причем
технологические установки, работающие по этому методу, позволяют гравировать
замкнутые изображения, то есть формировать бесконечный рисунок.

Обычно в лазерных установках прямого гравирования применяется газовый СО2­
лазер, излучение которого (10,6 мкм) хорошо абсорбируется различными
материалами, например резинами различного состава. Гравирование рельефного
изображения требует применения лазеров большой мощности — от 50 до 1000 Вт.

Недостатки систем прямого лазерного гравирования:

- необходимость удаления продуктов горения;

- высокое энергопотребление;

- необходимость периодической замены силовых элементов лазеров.

Изготовление флексографских форм по технологии CtP с применением
маскированных фотополимеров получило широкое распространение в
производстве высококачественной печатной продукции. В качестве основы
маскированных фотополимеров используются фотополимеризующиеся композиции,
хорошо зарекомендовавшие себя при аналоговом изготовлении печатных форм.
Главной отличительной особенностью цифровых формных материалов является
наличие тонкого (несколько микрометров) масочного покрытия, поглощающего
лазерное излучение. Это покрытие удаляется с поверхности формной пластины в
процессе экспонирования инфракрасным лазером. В результате на поверхности
пластины создается негативное изображение, заменяющее фотоформу при
последующем экспонировании УФсветом. Поскольку маскированные фотополимеры
разработаны на основе традиционных фотополимеров для флексографии,
процессы их обработки одинаковы.

После удаления лазером масочного слоя в местах, соответствующих печатающим
элементам, экспонируется прозрачная подложка с целью создания основы
фотополимерной формы. Экспонирование для получения рельефного изображения
осуществляется через негативное изображение, созданное из масочного слоя.
Затем проводится обычная обработка, состоящая из вымывания
незаполимеризовавшегося фотополимера, промывки и доэкспонирования с
одновременной сушкой. [9]



Сокращение технологического цикла изготовления форм за счет отсутствия
фотоформ позволяет не только упростить допечатный процесс, но и избежать
ошибок, связанных с использованием негативов:

- отсутствуют проблемы, возникающие вследствие неплотного прижима фотоформ
в вакуумной камере и образования пузырей при экспонировании фотополимерных
пластин;

- не существует потери качества, вызванного попаданием пыли или других
включений между фотоформой и пластиной;

- не происходит искажения формы печатающих элементов изза низкой оптической
плотности фотоформ и так называемой мягкой точки;

- отсутствует необходимость работы с вакуумом;

- профиль печатающего элемента оптимален для стабилизации растискивания и
точной цветопередачи.[4]

При записи изображения с помощью лазерных систем размер точки на
маскированных фотополимерах, как правило, равен 1525 мкм, что позволяет
получать на форме изображения с линиатурой 180 lpi и выше.

В 1997 г. предприятия BASF Drucksysteme, Schepers Druckformtechnik, Saueressing и
AKL Warburg совместно предложили для записи печатных форм используется
установка “Компьютер-печатная форма” шведской фирмы Misomex под названием
Omnisetter для записи как на флексографские пластины, так и на некоторые
термочувствительные формные пластины для офсетной печати, поскольку такие
машины есть в России. В качестве записывающей системы используется источник
излучения, состоящий из 20 лазерных диодов с длиной волны 830 нм.[4]

 Заключение
В данном курсовом проекте описан подробный процесс допечатной подготовки в
флексографской печати для производства картонной упаковки; при
проектировании крайне важно соблюдать особенности флексографской печати, в
частности, дисторсию и углы поворота растра. Список типичных требований,
предъявлямых российскими типографиями для подобной упаковки, приведен в
Приложении.



1. Приложение

Технические требования к оригинал-макетам, предоставляемым для цветоделения

1. Файлы принимаются в форматах *.ai (Illustrator), *.fh* (FreeHand), *.cdr
(CorelDraw).

2. Растровые изображения должны быть связаны и помещаться в отдельную
директорию.

3. Формат растровых изображений: *.tif, *.psd. В отдельных случаях может быть
*.jpg

4. Разрешение растровых изображений должно быть не менее 200 dpi (желательно
300 dpi).

5. Для растровых изображений со сложным дизайном желательны файлы в
формате *.psd c рабочими слоями.

6. Файлы верстки желательно предоставлять в двух вариантах: со шрифтами,
переведенными в кривые, и со шрифтами, записанными в отдельную директорию.

7. Шрифты могут быть как стандарта True Type, так и стандарта Type1.

8. К файлам желательно прилагать цветную распечатку с указанием цветов,
которые должны быть неизменными.

9. Следующие параметры касаются технологических возможностей оборудования
для флексографского производства:

- Минимальная площадь растрового элемента 2% (цифровое клише), 3%
(аналоговое клише). Следует учитывать, что красочные градиенты, идущие,
например, из 100% заливки в 0%, на участках от 2(3)% до 0% будут иметь
заметную контрастную полосу там, где заканчивается 2(3)% заливки. Для
устранения этого явления данные участки будут иметь заполение 2(3)%, что
сделает изображение несколько темнее на светлых участках.

- Минимальный размер воспроизводимого шрифта 2 пт (с засечками и без засечек).

- Минимальный размер шрифта, воспроизводимого вывороткой в одном краске, 5 пт
(аналоговое клише, шрифт с засечками), 3 пт (аналоговое клише, рубленый
шрифт), 2 пт (цифровое клише шрифт с засечками и рубленый).



- Минимальный размер шрифта, воспроизводимого вывороткой в трех красках, 4 пт
(аналоговое и цифровое клише, шрифт с засечками), 3,5 пт (аналоговое и цифровое
клише, рубленый шрифт). Однако, данный текст будет в большинстве случаев
выглядеть нечитабельно (это касается и шрифтов с более высоким значением
кегля, в среднем до 12 пт), поэтому такому тексту необходимо дать монокрасочную
обводку (толщиной 0,2-0,3 мм). Это касается текстов с вывороткой в двух и более
красках.

- Минимальный размер воспроизводимого штриха 0,05 мм.

- Минимальный размер штриха, воспроизводимого вывороткой в одной краске, 0,09
мм (аналоговое клише), 0,05 мм (цифровое клише); в трех красках 0,11 (аналоговое
клише), 0,1 (цифровое клише). Штриху вывороткой в двух и более красках
необходимо присваивать обводку, т.к. вышеозначенные параметры нестабильны.
Стабильная толщина выворотной линии составляет 0,5 мм.

- Минимальный размер точки 0,1 мм.

- Минимальный размер точки, выполненной вывороткой в одной краске, 0,18 мм
(аналоговое клише), 0,1 мм (цифровое клише); в трех красках 0,24 мм (аналоговое
клише), 0,18 мм (цифровое клише).

- Зона вкопирования (треппинг): 0,11 мм (минимум), 0,15 мм (оптимальное
значение).[8]
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